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Preface

Using the Ariba Adapter describes how to use the Ariba adapter in your SOA composite
applications and Oracle Service Bus business services.
This section consists of the following topics:

e Audience

e Related Resources

e Conventions

Audience

Using the Ariba Adapter is intended for users who want to create, deploy, test, and monitor
applications that use the Ariba adapter.

Related Resources
For more information, see these Oracle Resources:
e Developing SOA Applications with Oracle SOA Suite
o Administering Oracle SOA Suite and Oracle Business Process Management Suite
e Administering Oracle Service Bus

e Understanding Technology Adapters

Conventions

The following text conventions are used in this document:

Convention Meaning

Boldface type indicates graphical user interface elements

boldface associated with an action, or terms defined in text or the glossary.
o Italic type indicates book titles, emphasis, or placeholder
italic ; . X

variables for which you supply particular values.
monospace Monospace type indicates commands within a paragraph, URLSs,

code in examples, text that appears on the screen, or text that you
enter.







1.

Introduction to Ariba Adapter

This section introduces the Ariba Adapter.

This chapter consists of the following sections:
o Differences Between Using this Component in the Cloud and On-Premises Environments
e About the Ariba Adapter
e Ariba Adapter Use Case

e Pre-requisites
e  About Ariba Integration Methods

e Currently Supported Integrations Methods

e Enabling Integrations Task in Ariba

e Generating a WSDL File to call Ariba with SOAP adapter

e Installing the Cloud Adapters

e Performing Postinstallation Configuration Tasks

e Obtaining the Authentication Credentials

e Unsupported Features

Differences Between Using this Component in the Cloud and On-
Premises Environments

There may be differences between using this component in the cloud and on-premises
environments that impact the information described in this guide.

For information about differences, see Differences Between the Cloud and On Premises
Environments and Known Issues for Oracle SOA Cloud Service.

About Ariba Adapter

Ariba is a SaaS-based application that integrates and automates B2B Procurement processes with
Ariba solutions. Ariba Adapter enables you to do B2B transactions between buyers and suppliers
and it also allows you to import and export master and transactional data integration between
ERP Systems and Ariba Procurement Solution P2P or P20.

Avriba is a Cloud based B2B marketplace where buyer and supplier can find each other and can
do business with each other on a single platform. Ariba comes mainly as a Buyer and Supplier
Module where each one of them can do business. A buyer can search about the supplier, procure
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goods and services and track spend. Suppliers can manage their catalogs, purchases, bids and
invoices.

Avriba is the best solution for today’s increasing businesses and for manufacturing companies to
have a close collaboration with their partners, resource vendors and customers. This requires
sharing information, real-time status reports and documents as well as collaborating on critical
business processes like procurement, e-Commerce, e-invoicing, and other operations. SAP Ariba
is the marketplace for modern business, creating simple, intelligent exchanges between millions
of buyers and sellers.

The Ariba Cloud Adapter enables you to create an integration with a Ariba SaaS application.
This Cloud adapter framework securely connects and integrates data with Ariba and ERP
systems.

The Ariba Cloud Adapter for Oracle SOA Middleware is used for implementation of round-trip
communication between ERP systems and Ariba.

The Ariba Cloud Adapter provides the following features:

Avriba Cloud adapter allows integration of Ariba Procurement solution with ERP system and
allows administrators to import master data and export transactional data from any ERP systems
to a procurement system seamlessly.

Ariba Adapter Use Case

This use case describes how a Manufacturing company used the SAP Ariba Adapter to simplify
supply chain management, reduce order complexity, and improve the efficiency of supply
operations.

e A customer makes an online purchase of a Material produced by the Manufacturing company.
e The SAP Ariba Adapter sends the purchase request to the Manufacturing company.
e The Manufacturing company locates the requested Material and prepares it for shipment.

e The Manufacturing company uses the SAP Ariba Adapter to inform the customer that the
purchase has been shipped and provides tracking information.

e The SAP Ariba Adapter updates the inventory information for the product ordered by the
customer.

e The real-time integration patterns supported by the adapter can be either Web service based or
ITK based.

e The adapter can handle all types of sourcing and Procurement flows that are used in
manufacturing companies, to import and export the master and transactional data between
Ariba and ERP systems.

Pre-requisites
This section describes the pre-requisites required to use the Ariba adapter:

e The User must have Ariba User account and Credentials for creating CSF key in SOA.

e Based on this security key the user can call the Ariba Application from SOA.

Note: Admin should give the permission and credentials to the User for creating CSF key in
SOA.
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About Ariba Integration Methods
Acriba Application supports three types of methods to integrate data.
o File-based integration (ITK)
e Web Service based integration
e  Ariba Network

File-based integration(ITK)

Ariba ITK (Integration Tool Kit) allows buyers to integrate Ariba with any ERP system to
exchange master and transactional data via CSV file upload and download

Web Service based integration

It is a direct connectivity to Ariba, based on WSDL we will develop the APIS and we can
directly connect Ariba Application to upload and download master and transactional data , Ariba
SOAP web services use the W3C SOAP messaging framework to exchange messages over
HTTP or HTTPS.

The Ariba Integration Manager generates descriptions of the Ariba SOAP web services
operations in the Web

Services Description Language (WSDL), an XML-based language. Typically, developers on the
EAI system use the WSDL descriptions when creating Integrations to communicate with Ariba
SOAP web services.

Currently Supported Integration Methods

Currently the Adapter supports only outbound Web services data integration with the Ariba
Application and ERP System.

Enabling Integration task in Ariba

You need to enable the Integration task in Ariba before performing any operation in SOA.

Note: If the operation (Event) is not enabled in the Ariba application, the data will not be sent
to the Ariba application for that event (Operation).

1. On the Ariba Spend Management dashboard, click Manage and then click Administration.

HOME CONTRACTS PROCUREMENT CATALOG MORE...v Recent Manage
Catalog v | Keywords ~ Q :I\ C
Common Actions v Make your voice heard: cast your votes for future enhancements

Create

Requisition News o

Knowledge Project H . g
Announcing a new Flsher Scientific catalog®* Please see the link on the Catalog Page.

Invoice

Contractor Survey

Procurement Home Page

Moare

Manage For all further information on EasyBuy and training related documents, please click the link https://shareone sri.com/corp/shs/procursmeant/EasyBuy/_layouts
. . /15/start aspat/

Administration

My Tasks

To Do

Core Administration v My Requisitions v My Receipts o

0 Denied 0 Denied
More
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2. From the left menu, click Integration Manager and then click Integration Configuration.

HOME PROCUREMENT CATALOG ADMINISTRATION MORE .~ Recent Manage

_ Integration Configuration
¥ Site Manager

Data Import/Export
Audit Log Search, edit, activate or deactivate data import/export tasks. Search fields are case-insensitive and you can enter all or part of a name

L]

Integration Manager

Data Import/Export Search Filters:

Data Definition

Integration Configuration Task Name:
End Point Configuration
Integration Toolkit Security Renzt (no value)

Master Data Default Values End Point: (no valus) —

> Customization Manager Status: || Enabled Disabled List Al

» User Manager

» Dashboard Manager Configuration = v
» Supplier Manager Tasks 1 Format Enabled Supported Formats

3. Find the task you want to enable. Select List All or enter search criteria and click Search.
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4. For the task, click Action and then click Edit. An Edit data import/export task pane appears as

shown in the figure.

¥ Integration Manager
Data Import/Export Task Name

Data Definition

Format Web Senvice v

Integration Configuration

End Point Configuration End Point InboundEndpaint  ~
Integration Toolkit Security
Supplier Integration Configuration Status:

+ Enabled o/ Disabled

» Master Data Manager
Configuration

» Supplier and Customer Manager

Tasks 1
[Deprecated] Upl

» User Manager

oad document
» Customization Manager a

Qrganizations

» Reporting Manager
» Project Manager
» Dashboard Manager

» Commodity Code Manager

5. In the Status field, select Enabled.

HOME PROCUREMENT CATALOG ADMINISTRATION MORE. .«

Edit data import/export task

Activate or deactivate task, specify integration format and connectivity information

Name: Catalog ltem Search  View WSDL

Description:  Search for Catalog ltems

status:  ® Enabled

Disabled

Format:  Web Service

Type: Inbound to Ariba System
End point:  InboundEndpoint_Test ~ | @

URL-*

nc. This has been deprecated. Use Impart Document, Impart Form Document ar Impart Sourcing Event

Format

Web
Senice

Web
Senvice

Recent

6. Use the drop-down menu for the End point field to select an end point.

Enabled Supported Formats
No [Web Semice]

No [Web Senice]
Edit

Enable

Disable

Manage

Create v

Save

7. If you are configuring a service that uses an outbound end point, specify the URL for the

corresponding endpoint on the EAI system.
8. Click Save.

Generating a WSDL File to Call Ariba with SOAP adapter:

Follow the steps mentioned below for generating WSDL in Ariba:

1. On the Ariba Spend Management dashboard, click Manage and then click Administration.

2. Click the expansion arrow for Integration Manager.
3. Select Integration Configuration.
4

Find the task for which you want to generate the WSDL file. Select List All or enter the search

criteria and click search.
Click Actions and then Edit for the task.
6. Click the View WSDL link.

o
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HOME PROCUREMENT CATALOG ADMINISTRATION MORE.. »

Recent Manage
Edit data import/export task

Activate or deactivate task, specify integration format and connectivity information.
Name: Catalog ltem Search  View WSDL
Description:  Search for Catalog ltems
Status: L) Enabled Disabled
Format: Web Service
Type: Inbound to Ariba System
End point: InboundEndpoint_Test ~ @

URL-*

Save Cancel

When you click the View WSDL link shown in the above picture, the WSDL opens in the

browser and you can save it in your local system and then expose that as a SOAP service in
SOA.

Installing the Cloud Adapters

See the README.txt available with the patch for instructions on installing the cloud adapters.

After you complete the adapter installation, perform the tasks described in Performing
Postinstallation Configuration Tasks.

Note: For information about supported versions and platforms, see the release certification
matrix at Supported System Configurations.

Performing Postinstallation Configuration Tasks
You must perform postinstallation configuration tasks after installing the cloud adapters.

For information about postinstallation configuration tasks, see the Oracle Cloud Adapters
Postinstallation Configuration Guide.

Obtaining the Authentication Credentials

To access Ariba you must have an existing SAP Ariba user account. A user account is required
to provide the credentials necessary to create the connection and integration.

The Admin user can provide Security Credentials to the user by creating new permissions for
inbound and outbound Endpoint Configuration.

The same credentials can be used by the end user while creating the connection and integration
in SOA & OSB.

Unsupported Features
The adapter does not support the following features:

o  Adapter runtime retry configuration properties such as jca.retry.count, jca.retry.backoff,

jca.retry.interval, and jca.retry.maxinterval.
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Message recovery in the Error Hospital in Oracle Enterprise Manager Fusion Middleware
Control.

The display of properties in the Properties tab for a reference (outbound) adapter in Oracle
Enterprise Manager Fusion Middleware Control (for example, service WSDL URL, CSF key
used, and others). These are the reference adapters that you select on the Services and
References page.

Rejected message handling

The following message encryption and decryption features available when you right-click a
cloud adapter in the Exposed Service swimlane or External References swimlane in Oracle
JDeveloper:

o Protect Sensitive Data > Encrypt Request Data for cloud adapters in the
Exposed Service swimlane.

o Protect Sensitive Data > Decrypt Sensitive Data for cloud adapters in the
External References swimlane.

The policy attachments feature available when you right-click a cloud adapter in the Exposed
Service swimlane or External References swimlane in Oracle JDeveloper.
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2.

Creating an Ariba Adapter

Connection

The section introduces the Ariba Cloud Adapter.
This chapter consists of the following topics:

e Designing an Integration with the Adapter Configuration Wizard

e Monitoring Your Application During Runtime

e Artifacts Creation

Designing an Integration with the Adapter Configuration Wizard

You use the Adapter Configuration Wizard to include the Ariba adapter in a SOA composite
application or an Oracle Service Bus business service.

The Adapter Configuration Wizard consists of configuration pages that enable you to select the
artifacts required to communicate with the Ariba Cloud application. You can configure the
adapter in the outbound (target) direction.

1. The Basic Info page prompts you to enter a meaningful name and optional description.
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@ Configure a Ariba Cloud Connection - Step 1 of 4

Welcome to the Cloud Connection Configuration Wizard

This wizard helps you create a service using the Ariba Cloud Connection.

Basic Info
‘fou will be asked to specify configuration parameters and define an operation for the service.

*What do you want to call your endpoint?

+ Connection
I

AribaReference

What does this endpoint do?

Help Next = Cancel

2. The Connection page prompts you to specify the Ariba Host Name, Application Name,
Partition Name and Security Policy and Authentication Key to use. The authentication key is
created by clicking the Add icon to specify the key name, user name, and password. You must
also specify these same values in Oracle Enterprise Manager Fusion Middleware Control. For

instructions, see the Oracle Cloud Adapters Postinstallation Configuration Guide.

ﬂ Configure a Ariba Cloud Connection - Step 2 of 4

Ariba Cloud Server Connection

Ariba server credentials required to access Ariba and resources

T Basic Info

@ ‘Connection

Jr Operafions @ Where can I find the Objects you need?
*Host Name: | =================== |
*Application Name: | xxxxxxxxx |
*Partition (Site Name): | =========== |

@ Pick the key to getin the door
Security Policy: |CUSTDM v|

=uthentication Key: |admir1 v| % 7 X

Test

Refresh MetaData Cache:

Help < Back Next > Cancel

3. The Operations page prompts you to select the target operation that you are going to perform in
the Ariba Application.
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© Configure a Ariba Cloud Connection - Step 3 of 4

Configure the operation to perform in the target Ariba application.

Connection
T
) Operations

|
& Summary

Help

Select the target operation to perform in the Ariba application.

Ariba Solution:

Operations: Q, Filter by operation name

d rganizations
(Create External Request For Approval
ICreate Event

\Add Users To Group

Import Contract Workspace

[Create Sourcing Project

Import Sales Contract Request
Import Document

Process Requisition Externally

Import Contract Line Items Document
Import Sales Contract Workspace

Description:

< Back Mext = Cancel

4. The Summary page displays your selections for the outbound direction.

Summary

) Configure a Ariba Cloud Connection - Step 4 of 4

Basic Info
Connection

Operations

- —e—¢

| Summary

Help

Here's a summary of all the choices you've made and some Next steps.

Selected Module:  Buyer

Selected Operation:

< Back Einish Cancel

5. The Adapter will be visible in the External references of JDeveloper.
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Exposed Services Components External References

g e
D=

E AribaReference

i Operations:

i || RemittancePullNotify

Design| Source History Annotations

Monitoring Your Application During Runtime

This section describes the design time and runtime aspects of using the Ariba adapter. You use
the runtime part of the adapter for delivering the information generated during design time to the
service endpoint. You can monitor your SOA composite application or Oracle Service Bus
business service from Oracle Enterprise Manager Fusion Middleware Control. You can also test
your Oracle Service Bus business service from Oracle Service Bus Console.

Artifacts Creation

The following artifacts are created for each adapter instance in the Applications window in
Oracle JDeveloper:

o WSDL file: Only the standard WSDL file type is supported.

o JCA file: Contains the internal implementation details used by the adapter during runtime. It
contains the different interaction and connection properties used by the adapter.

When application configuration is complete, you can deploy the application from Oracle
JDeveloper to the runtime environment.

For information about the details to specify in the fields of the wizard pages, see Configuring
Oracle Ariba Cloud Connection Properties.
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3.

Designing SOA Composite
Applications

This section describes how to design a SOA composite application with the Ariba cloud adapter.
This section consists of the following topics:

e Creating a SOA Composite Application

e Adding an Adapter to a SOA Composite Application as a Reference

e Completing Design of a SOA Composite Application

Creating a SOA Composite Application

This section provides an overview of how to create a SOA composite application in which to
include the adapter as an exposed service or external reference.

1. Start Oracle JDeveloper.
2. From the File menu, select New > Application.

3. Inthe New Gallery dialog, select SOA Application from the Items list, then click OK. The
SOA Create SOA Application wizard is displayed.

4. Specify an application name, and click Next.
5. Specify a project name, and click Next.
6. Select Composite with BPEL Process, and click Finish.
The SOA composite application is displayed for designing in the SOA Composite Editor.
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Adding an Adapter to a SOA Composite Application as a Reference

You can add an Ariba Cloud Cloud adapter to a SOA composite application as an outbound
(target) reference to the External References swimlane in Oracle JDeveloper.

1. Go to the Component Palette in your SOA composite application.

2. Go to the Cloud section under Custom/Third Party.

The adapters are displayed.

3 Start Page D{[‘ﬂ Projectl . Components Resources
& Pld R B9 B @ Project1 | O
Components External References fan
e
& @ & < ® &
BPEL Process  Business Rule Human Task Mediator Spring Subprocess
Technalogy
= i & < & @ &8 &
~ ADF-BC AQ BB BAM Coherence Database Direct EB
To create resources, drag and drop an icon
3 = oy o
from the component palette to the canvas {% et i B {8 ﬁ—;’ @
File FTP Healthcare HTTP IMS LDAP MFT MQ
select one from the right-click context menu -
i@ & & @ &
MSMQ REST SOAP Socket ums
applications
@ * *
E-Business IDE World SAP
Suite
CustomfThird Party
@
Jesign| Source History Annotations Third Party
Messages - Log Cloud
juild after save building project Z of Z gueued projec ey : o i
AF{IBA CI?) @ C,;) C,:) SaIEs.f\:u =3

ompiling.. .
‘ompilation of project 'Brojectl.jpz' fimished. Check

12:58:15 DM] Successful compilaticn: 0 errors, 0 warni

Elogua
Adapter

Net5uite
Adapter

Orade ERP
Cloud

Orade
RightNow

Orade Sales
Cloud

ServiceNow

=

uild after save finished Surressfar...

3. To create an outbound (target) reference, drag the adapter to the External References swimlane,
and see the following sections that describe the wizard pages for configuring the adapter

e Configuring Basic Information Properties

e Configuring Oracle Cloud Adapter Connection and CSF Key Properties

e Confiquring Ariba Adapter Invoke Operations Page

e Reviewing Configuration Values on the Summary Page

Completing Design of a SOA Composite Application

This section provides an overview of how to complete design of your SOA composite
application and deploy the application.

1. Design the remaining contents of your SOA composite application. For example:

a) Connect the BPEL process to the adapter. For this example, the BPEL process is connected
to the adapter as an external reference:

b) Design the contents of the BPEL process. For example:
a. Double-click the BPEL process.
b. Add and configure an invoke activity to invoke the adapter

c. Add and configure assign activities to copy the contents of one variable to
another when sending and receiving messages to and from the adapter.
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d. Add and configure other activities, as appropriate.

When complete, view the SOA composite application in the SOA Composite
Editor.

For specific information about creating and designing SOA composite applications, see
Developing SOA Applications with Oracle SOA Suite.

2. Deploy the SOA composite application:
a. In the navigator, right-click the project and select Deploy > project_name.

b. Follow the steps in the deployment wizard to deploy the SOA composite application to
the application server.
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4.

Designing Oracle Service

Bus Business Services

This section describes how to design an Oracle Service Bus business service with the adapter in
Oracle JDeveloper.

e Creating an Oracle Service Bus Business Service

e Adding an Adapter to a Business Service as a Reference

e Completing Design of an Oracle Service Bus Business Service

Creating an Oracle Service Bus Business Service

This section provides an overview of how to create an Oracle Service Bus business service in
which to include the adapter in Oracle JDeveloper.

Start Oracle JDeveloper.

From the File menu, select New > Application.

In the New Gallery dialog, select Service Bus Application from the Items list, then click OK.
Specify an application name, and click Next.

Specify a project name.

© ok~ w DN E

Select Service Bus, and click Finish.

The Oracle Service Bus business service is displayed for designing in the Oracle Service Bus
Overview Editor.

Adding an Adapter to a Business Service as a Reference

You can add the adapter to an Oracle Service Bus business service as an outbound (target)
external service to the External Services swimlane in Oracle JDeveloper.

Note: If the Import OSB Resource dialog is displayed during adapter configuration, click
Cancel. You cannot localize the WSDL file.

1. Go to the Component Palette in your Oracle Service Bus business service.
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2. Go to the Cloud section under Custom/Third Party.
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3. To create an outbound (target) external service, drag the adapter to the External Services
swimlane, and see the following sections that describe the wizard pages for configuring the

adapter:

e Configuring Basic Information Properties

e Configuring Oracle Cloud Adapter Connection and CSF Key Properties

e Configuring Ariba Adapter Invoke Operation Properties

¢ Reviewing Configuration Values on the Summary Page

Completing Design of an Oracle Service Bus Business Service

This section provides an overview of how to complete design of your Oracle Service Bus

business service and deploy the application.

1. Design the contents of your Oracle Service Bus business service. For example, to configure an
Oracle Service Bus proxy service in your business service:

a)

select Insert > Pipeline.

In the Oracle Service Bus Overview Editor, right-click the Pipeline/Split Joins lane and

The Create Pipeline Service dialog is displayed.

Select WSDL as the Service Type.

Select Application.

9)
h)

Enter a name for the pipeline and select the project location, then click Next

To the right of the WSDL selection, click the Browse icon to select the WSDL.

Expand Resource Chooser and select the WSDL file, then click OK.

Ensure that Expose as a Proxy Service is selected.

From the Proxy Transport list, select http, then click Finish.

The Pipeline component is displayed in the Oracle Service Bus Overview Editor.

i) Connect the external service to the Pipeline component.

Designing Oracle Service Bus Business Services 4-2



For more information about creating and designing an Oracle Service Bus business service,
see Developing Services with Oracle Service Bus.

2. Open the pipeline that shows the default routing.

3. Verify the service and corresponding operation are displayed in the Routing Properties tab at the
bottom of the dialog.

The outbound project is ready for deployment.
4. Deploy the business service.

Note: You cannot use Oracle JDeveloper to deploy a business service to Oracle SOA Cloud
Service. For information about other deployment options, see Using Oracle SOA Cloud Service.

a) Select the project, then select Deploy to Service Bus Server.

b) Follow the steps in the deployment wizard.
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D.
Configuring Ariba Adapter

Properties

The Ariba Cloud Adapter enables you to create integrations with a Ariba Saas cloud application.

The following sections describe the wizard pages that guide you through configuration of the
Ariba Cloud Adapter as an invoke in an integration. The Ariba Adapter cannot be configured as
a trigger in an integration.

This chapter consists of the following topics:

e Configuring Basic Information Properties

e Configuring Oracle Cloud Adapter Connection and CSF Key Properties

e Configuring Ariba Adapter Invoke Operation Properties

¢ Reviewing Configuration Values on the Summary Page

Configuring Basic Information Properties

You can enter a name and description on the Basic Info page of each source and target adapter in
your integration.

This section consists of the following topics:

e What You Can Do from the Basic Info Page

¢ What You See on the Basic Info Page

What You Can Do from the Basic Info Page

You can specify the following values on the Basic Info page. The Basic Info page is the initial
wizard page that is displayed whenever you drag an adapter to the trigger (source) or invoke
(target) area supported by your adapter.

o  Specify a meaningful name.

o  Specify a description of the responsibilities.

What You See on the Basic Info Page

The following table describes the key information on the Basic Info page.

Element Description
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What do you want to call your endpoint? Provide a meaningful name so that others can
understand the responsibilities of this
connection. You can include English
alphabetic characters, numbers, underscores,
and dashes in the name. You cannot include
the following:

e Blank spaces (for example, My
Inbound Connection)

e Special characters (for example,
#;83& Orrigh (t)nowd)

e Multibyte characters

What does this endpoint do? Enter an optional description of the

connection’s responsibilities. For example:
This connection receives an

inbound request to synchronize
account information with the
cloud application.

Configuring Oracle Cloud Adapter Connection and CSF Key
Properties

Enter the Oracle Cloud adapter configuration connectivity and Credential Store Framework
(CSF) key values for your integration.

This section consists of the following topics:

e What You Can Do from the Oracle Cloud Adapter Connection Page

¢ What You See on the Oracle Cloud Adapter Connection Page
e What You Can Do from the Oracle Cloud Adapter CSF Key Page
¢ What You See on the Oracle Cloud Adapter CSF Key Page

What You Can Do from the Oracle Cloud Adapter Connection Page

You can specify the following connection values for the Oracle Cloud adapter.

o Specify the WSDL URL for some adapters. For Ariba Cloud adapter you need to specify the
HostName, Application Name, and Partition Name.

e  Specify the security policy.

o Create the authentication key. A key created for one direction (for example, outbound) is also
available for selection in the other direction (for example, inbound).

What You See on the Oracle Cloud Adapter Connection Page

The following table describes the key information on the Oracle Cloud Adapter Connection

page.

Element Description

H N In the Host Name field, enter the host name of the
ost Name SAP Ariba server..
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For example: https:/ /sl.ariba.com

Application Name

In the Application Name field, select Buyer or
Supplier.

Partition Name

In the Partition (Site Name) field, enter the name
of the SAP Ariba server partition on which you
want to execute operations.

Ex:***** /Procurement.s1.ariba.com

Security Policy

Select the security policy appropriate to your
environment (for example,
USERNAME_PASSWORD_TOKEN).

¢ The wizard shows all policies, including
those that may not be applicable. To make
a correct selection, you must have a
knowledge of policies. For example, you
cannot select a SAML-based policy
because the identity is not propagated.

* The policies you apply to the cloud
adapter are unique to the cloud adapter
and do not impact other endpoints in the
composite.

Authentication Key

Select the CSF authentication key.

* Add: Click Add to create a new authentication
key. You must specify the key name, user name,
and password.

* Edit: Click to edit an authentication key.

* Delete: Click to delete an authentication key.

Test

Click to validate the authentication key.

What You Can Do from the Oracle Cloud Adapter CSF Key Page
You can specify the following CSF key values for the Oracle Cloud adapter.

e CSF key name

e User name and password

e Re-enter password

What You See on the Oracle Cloud Adapter CSF Key Page
The following table describes the key information on the Oracle Cloud adapter CSF Key page.

Element

Description

CSF Key Name

Specify the CSF key to enable runtime
injection of credentials. The adapter uses the
CSF to retrieve the username and password
required for authentication with the
application (for example, the Oracle Sales
Cloud or Oracle ERP application). This key
identifies your login credentials during
design-time.

User Name

Enter the user name for connecting to your
application (for example, the Oracle Sales
Cloud or Oracle ERP application). Your
administrator provides you with user
credentials.

Password

Enter the password for connecting to your
application.
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Re-enter the same password a second time.

Re-enter Password

Configuring Ariba Adapter Invoke Operation Properties
Enter the Ariba Adapter invoke operation values for your integration.
This section consists of the following topics:

e What You Can Do from the Ariba Cloud Adapter Invoke Operations Page

e What You See on the Ariba Cloud Adapter Invoke Operations Page

What You Can Do from the Ariba Cloud Adapter Invoke Operations Page
You can configure the following invoke operation values for the Ariba Adapter.
e Select the operation to perform.

e Select the business object on which to perform the operation.

What You See on the Ariba Adapter Invoke Operations Page

The following table describes the key information on the invoke Operations page.

Element Description

Click Next Steps This feature is not currently available.

Select Operation Type e Import Contract Workspace — Imports
contract workspace information from an
external application into the SAP Ariba
application

* Create Suppliers — Imports supplier
information from an external application into
SAP Ariba.

* Create Event — Imports event information
from an external application into SAP Ariba.

* Create External Request For Approval —
Imports external requests for approval from an
external application into SAP Ariba.

* Create Remittance — Returns the amount
paid to suppliers for each invoice. Select this
operation when remittance information is
imported from an ERP application directly into
SAP Ariba.

* Create Sourcing Project — Creates a
sourcing project.

* Create Organizations — Creates an
organization.

¢ Create External Contract Information —
Returns contract information from external
applications.

¢ Create Procurement Unit — Imports
procurement unit information from an external
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application into SAP Ariba.

* Create Requisitions — Imports requisition
information from an external application into
SAP Ariba.

* Catalog Item Search — Searches for catalog
items in SAP Ariba to allow the
synchronization of operations between SAP
Avriba and external applications.

Filter by object name Type the initial letters to filter the display of
business objects.

Reviewing Configuration Values on the Summary Page
You can review the specified adapter configuration values on the Summary page.
This section consists of the following topics:

e What You Can Do from the Summary Page

¢ What You See on the Summary Page

What You Can Do from the Summary Page

You can review source or target configuration details from the Summary page. The Summary
page is the final wizard page for each adapter after you have completed your configuration.

¢ View the configuration details you defined for the source or target adapter. For example, if
you have defined an inbound source adapter with a request business object and immediate
response business object, specific details about this configuration are displayed on the
Summary page.

e Click Done if you want to save your configuration details.

e Click a specific tab in the left panel or click Back to access a specific page to update your
configuration definitions.

e Click Cancel to cancel your configuration details.

What You See on the Summary Page

The following table describes the key information on the Summary page.

Element Description

Displays a summary of the source or target
configuration values you defined on previous
pages of the wizard.

For adapters for which a generated XSD file is
provided, click the XSD link to view a readonly
version of the file.

To return to a previous page to update any
values, click the appropriate tab in the left
panel or click Back.

Summary
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6.

Managing Applications

This section describes how to manage and monitor an Oracle SOA Suite or Oracle Service Bus
application that uses the adapter from Oracle Enterprise Manager Fusion Middleware Control or
Oracle Service Bus Console.

This chapter consists of the following sections:

e Managing the Application in Oracle Enterprise Manager Fusion Middleware Control

e Testing Oracle Service Bus Projects from Oracle Service Bus Console

Managing the Application in Oracle Enterprise Manager Fusion
Middleware Control

You manage the SOA composite application or Oracle Service Bus business service that includes
your adapter in Oracle Enterprise Manager Fusion Middleware Control.

1. Log into Oracle Enterprise Manager Fusion Middleware Control.

2. Inthe navigator, expand the tree to display your SOA composite application or Oracle Service Bus
business service project (for this example, a SOA composite application is selected).

3. Select the SOA composite application.
4. Click Test.
The Test Web Service page is displayed.
5. Complete the fields on the page to initiate a test of your composite.
6. Click Test Web Service.
Invocation results are displayed.

7. Click Launch Flow Trace to view the flow trace of the SOA composite application, including
flow details about the adapter.

For more information about monitoring applications from Oracle Enterprise Manager Fusion
Middleware Control, see Administering Oracle SOA Suite and Oracle Business Process
Management Suite and Administering Oracle Service Bus.

Testing Oracle Service Bus Business Services from Oracle Service
Bus Console

You can test Oracle Service Bus business service projects from Oracle Service Bus Console.

1. Log into Oracle Service Bus Console.

2. Inthe navigator under All Projects, open the project to test.
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3. Inthe navigator, click the business service for that project.

4. Click the Launch Test Console (green arrow button) to test the outbound endpoint.
This opens a window that displays the proxy service and the operation to test.

5. Provide the input and click Execute.

This sends the payload to the Oracle Cloud application. The response is displayed under the
Response Document section.

For more information about testing Oracle Service Bus business service projects, see
Administering Oracle Service Bus.
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Troubleshooting

The following table describes the troubleshooting information.

Error Cause Solution
javax.net.ssl.SSLHandshakeExcepti | When Ariba Server is Update the

on: Server chose TLSv1, but supporting TLSv1 and SOA | Weblogic.security.SSL.minimumProtocol
that protocol version is not enabled | is ending request with TLS | Version=TLSv1”in the

or not supported by the client version greater than TLSv1l | “setStartupEnv.sh” file
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